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DWC-MB950TIR

IP 5MP Weather Proof Bullet Camera
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Before installing or operating the camera, please read and follow this manual carefully.
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PRECAUTIONS

" Do not open or modify.

. Do not open the case except during maintenance and installation, for it may be dangerous and can cause
damages.

] Do not put objects into the unit.

" Keep metal objects and flammable substances from entering the camera. It can cause fire, short-circuits, or
other damages.

" Be careful when handling the unit.

" To prevent damages, do not drop the camera or subject it to shock or vibration.

. Do not install near electric or magnetic fields.

" Protect the camera from humidity and dust.

" Protect the camera from high temperature.

. Be careful when installing near the ceiling of a kitchen or a boiler room, as the temperature may rise to high
levels.

. Cleaning: To remove dirt from the case, moisten a soft cloth with a soft detergent solution and wipe.

" Mounting Surface: The material of the mounting surface must be strong enough to support the camera.

FCC COMPLIANCE

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of
the FCC rules. These limits are designed to provide reasonable protection against harmful interference, when the
equipment is operated in a residential environment. This equipment generates, uses, and radiates radio frequency
energy, and if it is not installed and used in accordance with the instruction manual, it may cause harmful interference
to radio communications.

WARNING: Changes or modifications are not expressly approved by the manufacturer.
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FEATURES*

ONVIF Compliant Profile S

5 Megapixels (2592x1920, 10fps) Resolution

Triple Codecs (H.264, MJPEG, MPEG4) with Dual-Stream
1/2.5” 5SMP CMOS Sensor (20% Larger Than 1/3” CMOS Sensor)
3.4~10mm Remote Auto Focus Lens

3X Optical Zoom

80ft IR with Intelligent Camera Sync

TDN (True Day and Night)

Power over Ethernet [PoE] & 8~25VDC, and AC24V
Two-Way Audio

Micro SD/SDHC Class 10 Card for Emergency Backup
IP67 Certified (Weatherproof)

Web Server Built-in

DNR (Digital Noise Reduction)

Programmable Privacy Zones (5) & Motion Detection
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PARTS & DESCRIPTIONS*
[5]

Mounting Bracket

Pan & Tilt Adjusting screws
Lens

IR LEDs

Sunshield Cover

Camera Module

o gk wbhPE

[4]

3]

[1]




1x RJ45 Connector
2x Sensor Input

1x Alarm Output
1x Ground

PARTS & DESCRIPTIONS*

= SD CARD Slot

bW

1x RJ45 Netowkr Port
Power Terminal Block
WiFi Network Connector

DC Power

Reset Switch

Audio In/ Out

Camera Part

Description

1| RS485 +/- RS485 connections for remote camera control

2 | Sensor Inputs +/- Connect up to 2 sensor inputs to the camera

3| Alarm Output +/- Connect 1 Alarm output control from the camera

4| SD Card Slot Micro SD card slot for local storage (not included)

5| Network Port RJ45 Cable Connection Port

6| Audio In/ Out Built-in Microphone and Audio Amplifier output connector

7 | Power Ports DC Power port and AC + DC Cable power connectors available
8 | Reset Switch Reset the camera to factory default values
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INSIDE THE BOX - MB950TIR*

The following items are included with the MEGAPIX camera.

i Mo bW
. Quick Setyp Guide C D R
chk_ Start (Manual & e
Guide ey ...
Q =@ B o o
4x Mounting
L-Wrench Screws & Wall
Anchors
2nd Video DC Cable
Output Adapter Adapter
2x Drying Mounting
Packets- Silica Template
Gel Packet

Weather Proof

Bullet Camera

with Mounting
Bracket




NETWORK CONNECTION*

There are two options to power the MB950TIR camera.

Use a PoE-enabled switch to connect data and power through a single
cable and begin viewing and recording images instantly. A non-PoE
switch will require an adaptor for power transmission.

1.

Using a PoE-Enabled Switch

The MEGApix Camera is POE-Compliant, allowing transmission of power and data via a
single Ethernet cable. PoE eliminates the need for the different cables used to power, record,
or control the camera. Follow the illustration below to connect the camera to a PoE-enabled
switch using an Ethernet cable.

= —— _7

j e— | S—. A T—. ) -

PoE Switch

Using a Non-PoE Switch

If a PoE-enabled switch is not used, use a power adaptor for power transmission and non-
PoE switch for data transmission. Follow the illustrations below to connect the camera without
a PoE-Enabled Switch.

S

DC12v adaptor (not included)

Non-PoE Swifch
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INSTALLATION*

Drill hole
» “

Alignment Sticker

Drillihole
1. Use the camera’s mounting template 2.  Fix the mounting plate to the surface
to mark and drill the mounting holes. using the three (3) provided screws,

washers, and wall anchors.

3.  Mount the camera’s arm support onto the mounting plate.

4. To connect all appropriate cables to the camera and complete the installation, unscrew the
back cover of the camera.

10



INSTALLATION*

5. Remove the spindle fork connecting the camera module to the mounting bracket by pushing in
the spindle.

6. Screw the spindle fork on to the camera.
7. Set the camera onto the arm by pushing the spindle and placing the fork on the spindle.

11



INSTALLATION*

8. Tighten the screws on the other side of the spindle to lock the camera on to the mounting
bracket.

9. To adjust the camera’s pan and tilt, loosen the pan & tilt screw locks and adjust them
accordingly.

10. To adjust the camera’s lens, focus, and zoom, unscrew the front cover by rotating it counter
clock-wise.

11. Use the two handles at the base of the lens to adjust the focus and the zoom.

12



INSTALLATION*

12.

13.

14.

15.
16.

You may also use the 2nd Video output located near the camera’s lens for easy adjustment
during installation.

After adjusting the lens, remove a drying agent pack from one of the silver packages
stored inside the accessories package*.

Remove the sticker from the drying agent pack and insert it in the front under the lens as
shown in the image*.

Screw the front cover back on to the camera.

If using wide angle, shift the camera’s hood back to avoid blocking the view. Loosen
screws and shift back or forward as necessary.

* The drying agent pack should be replaced each time the camera is opened (front or back).
Be sure to complete all work before inserting drying agent pack & replacing the cover.
Drying agent packs will become ineffective if exposed to open air for more than 10 minutes.

13
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IP FINDER SOFTWARE*

Installing IP Scan Software

IP Finder searches for all the available Digital Watchdog devices
currently connected to your network.

1. Install IP Scan to find the MB950TIR Cameras on the local network. The IP Scan software
can be found on the included CD. Run IP Scan and install it onto your PC.

When setup is complete, launch the IP Scan software.

To find your MB950TIR cameras, click the Scan button.

You can use the DWScan software to adjust the camera’s IP Address and Network Settings
To change the camera’s Network Settings, press the Change Settings button.

ok~ Wb

Tapa F sooress WAC saaest “odn s LR

" sum‘.. e m
.

o
oy

°

A
°
2 4

Scan displays all devices on the network.
Use 192.168.1.2 IP, Model, and MAC Address
to identify a specific camera/video server.

L ——
Netwark Type
mecpe ¢ Shatic W ryoc
Use Change Setting to change A s

network settings. After clicking Apply, IPhddoeen: | 192 068 1. 2
enter "pass” for the root password D) 1% .., 1 .Y
Net Mark Al 55 b2 Y o
1

when prompted

DNE Server ! 150 " 1

*Install the IP Finder to a computer located on the same Subnet Mask as the MEGAPIX camera.
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IP FINDER SOFTWARE*

DHCP

The Dynamic Host Configuration Protocol (DHCP) is a network configuration protocol that allows a
device to configure automatically according to the network it is connected to.

If your network supports DHCP and your MEGAPIX camera is set to DHCP, IP Finder will
automatically find and set your MEGAPIX camera to correspond with your network requirements.

Static

Static IP addresses are recommended when using a network that does not support DHCP or when
setting your device to be accessed externally via the internet. If Static is selected, you must
manually enter the correct network settings for your MEGAPIX camera. The settings will
correspond with your network. To set your camera to a static IP address, we recommend that you
(1) setup the camera to DHCP, (2) allow it to configure itself according to your network, and (3)
change the settings to a static IP address.

1. To set your MEGAPIX camera to Static, highlight the desired device from the search results
list, and click on Configuration. In the “Network Configuration” window, make sure Static is
selected.

2. Enter the following information: IP Address, Netmask, Gateway, and Preferred DNS.
3. Click Apply and Reboot to save all changes.

DDNS

Dynamic Domain Name Server is a feature that allows you to use a specific URL instead of an IP
address to access your MEGAPIX camera. This feature is optional. It may require a subscription
and fee.

1. To use the DDNS feature, check the box next to Use DDNS.

2. Select the server you wish to use. *Some servers may require a subscription and fee.
3. If applicable, enter the User ID and Password.

4. Click Apply and Reboot to save all changes.

15
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CAMERA REBOOT*

Resetting the Camera

Pressing the reset button on the camera’s control board for six (5)
seconds will initialize all environmental variables to factory default.
Previous setup for IP default, time, etc. will be deleted. If a system’s IP
address is lost, reset the camera back to factory default.

The following are the default network settings.

IP Mode DHCP

IP Address 192.168.1.2
Subnet Mask 255.255.255.0
Gateway 192.168.1.1
Command Port 6002

HTTP Port 80

Live Port 554

Reset Switch

* Frequent use may cause system error.

16



WEBVIEWER*

Remote Video Monitoring Via Internet Explorer

Monitor and configure the MEGAPIX camera through a built-in web
viewer.

When accessing an IP camera using the web interface for the first time (or when the IP address
changes), some configuration for ActiveX controls are required.

1. Open an IE browser

2. Typeinthe IP address in the URL: http://<IP ADDRESS> (e.g. http://10.1.21.53).
3. Default Username and Password: root/ pass.
4

Pop-up windows and messages for download/run Active X controls (examples below) will
likely be displayed. Select Install or Run to all such messages. Click on the add-on
message and choose Run Add-on.

5. Repeat the above until all ActiveX controls have been initiated. Once the process is complete,
the Live View will be displayed in IE.

6. when all Active X files have been properly installed, the web viewer will display the camera’s
live video and control center.

Internet Explorer - Security Warning

The publisher could nat be yerified. Are you sure you want to install this
software?

Name: nwss,cab
Ew Publisher: Unknown Publisher
Fun Add-on on Al YWebsites
What's the Risk?

Install ] | DontInstal |

Infarmnation Bar Help showild anly install software From publishers you teusk, How can © decide what

@ This file does nok hawve a walid digital signature that verifies its publisher, You
sofbware to instal?

E e Vicwer

g_'! To help proteck vour security, Internet Explorer stopped this site from inska

* The web viewer can also be accessed via Firefox Mozilla and Google Chrome if QuickTime player

is installed.
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WEBVIEWER*

GUI Description

bW

8 Web Veewer - Windows Internet Explorer

£ hitp:/ /192168100148 inclex b

ot Favorites & Web Viewer

M.D IGITAL
VWATCHDOG

fye View | Setyup | Client Setup
PR YN 1 SN0 ) At D

Information

Resolution : 2592x1920
Frame rate: 8 fps

Streaming
Stream1 i]

Audio

a
a

Control

Speed (4 [+]

Preset 1

9]2)

s Zoom ‘

Focus g5

* IRIS 0

Video Display Size

Video Controllers

Alarm Indicators

Video Resolution & FPS Information

Audio Controllers

Lens Controllers

PTZ Virtual Controller

Stream Selection

Live/ Setup/ Client Setup Access
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WEBVIEWER*

Relay Input & Alarm Output Control

The MB950TIR supports 2 Sensor Inputs and 1 Alarm Control Output.
Use the camera’s Control bar and status indicators to manage the camera’s relay and alarm inputs

and outputs.

> The View Size controls adjust the viewable screen size in Live View. The Zoom feature can be
used once one of the zoom view modes is selected. See page 20 for more information.

> Record and Snapshot will capture video/snapshots to the local hard drive.

> Digital Out will trigger a digital output
signal (e.g. to an alarm).

> Full Screen will display video in full
screen mode. Click the Esc key to exit
Full Screen mode.

» SD Card shows the status of the SD
card.

> Digital In Alert will display when a
digital in alert has been triggered.

> Motion Detection Alert will display
when motion detection has been
triggered.

19

B Vieb Viewer - Windows Internet Explorer

@ * - PRI

SR —]

¢ Favorites B Wieb Viewer

DW R shbEs

BROBOBB Eo i san curi

Information

Resolution : 2592x1920
Frame rate: 8 fps

Streaming

Stream1 [+]

Audio

L
a
Control
"" > ;
Speed |4 [+]
Preset 1
2]
s Zoom B
o Focus _ @
& _IRIS
Snapshot  Screen Alert

QEO0B00B6 &«
Adjust e /4 T T \

Live View

i Record Digital sSD Motion
e Qut Card Detection
Alert
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WEBVIEWER*

Digital Zoom

The Digital Zoom feature allows zooming in on a specific area.

To control the Camera’s Digital Zoom:

1.

When using the View Size controls, a magnifying glass icon will replace the mouse

pointer icon. E

To magnify a specific area, place the magnifying glass icon over the desired area and left
click the mouse. Additional left mouse clicks will continue to magnify wherever the mouse
is placed.

To zoom out, right click the mouse.

If the mouse is moved to the edge of the image window, the mouse icon will change to a
white, triangular icon.

N

This icon allows moving the view using electronic PTZ if the functionality is available and
enabled.

20



WEBVIEWER*

First Stream & Second Stream

The MB950TIR supports multiple simultaneous streams (4 profiles)

The Streams can be switched from the camera’s web viewer by selecting the corresponding
stream from the drop down menu in the Steam Control option.

The stream’s current resolution and framerate information will be displayed in the information
section.

To setup the different streams:

a.

e.
See page 43 for more information. |CER s AEE BT 7

* Option not available on DW

Optimized Firmware

Go to ‘Setup’ at the top right-hand corner of the screen. The setup menu will appear.

b. Go to Video/Audio > Video Settings
C.
d

Select the number of profiles you would like to assign the camera.

. All selected profiles will appear under the Quality Setting Section. Here you can modify each

steams’ resolution, codec, bitrate, and max framerate.
Press ‘Save’ to save all settings.

DW e R rnde

i

.......

21



WEBVIEWER*

Export Image

Export a screenshot of the current live video to your computer.

1. Make sure the directory path has been setup. To do so:
1. Goto Client Settings at the top right-hand corner of the screen.
2. Press ‘Select Path’ to select the directory where all exported images will be saved to.

Settings will be saved automatically.

bW

3. Click on the ‘Live View’ link at the top right-hand corner of the screen to return to the

camera’s live display.

2. To export an image of the camera’s current live view, press the ﬂ button at the top control
bar. An image with time stamp will automatically be saved as a JPEG file.

£ Web Viewer - Windows leternet Exploret

p, 0o 19016810019 ex el

2 S l"'Cooq\.

o Favontes €8 Web Viewer

D o2 | SGITAL
WATCHDOS

oo egee s

Raenlutian = 2803w 1990
Frare rate: 8 fps

Information

Streaming

. Foius @&

Suycomi =)

| .

Zoom a

IfS
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WEBVIEWER*

Instant Recording

Record live video to your loc
To Setup Instant Recording

Make sure the directory path is setup. To do so go to Client Settings at the top right-hand corner of

the screen and press ‘Select Path’

To Start and Stop Instant Recording

al drive.

To Start, press thef.d icon on the control menu bar. A window will appear to notify you instant

recording has begun.

ThelEd button will blink red indicating you are currently recording video.
To Stop, press the £ button again. The video file will appear in the designated directory path.

Live View | Sety

Information

Resolution ; 2592x1420

Frame rate: 8 fps

Stureaming

Stream1 :: ]

Q
a

Audio

Control

Speed |4 [+]

Preset 1
a Zoom ‘
y . focus G

IRIS

B Veb ewer - Windows Internet Explorer = =2
ol = i: /192168100143 e bl DB l'-l Google £+
¢ Favorites € Vieb Viewet
DW.D 1 GITAL 1 s
WATCHDOG 2606 IEJU 86 .

—raE ‘
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WEBVIEWER*

Controlling the Camera using the Virtual Joystick

Use the different buttons in the Pan/ Tilt Controller to adjust the camera’s
position, zoom and focus, and control the camera’s PTZ functions.

To control the Camera’s Pan, Tilt, and Zoom

1.

PTZ Directional Buttons-When the camera is in zoom, use Coi ‘
the directional arrows to control the zoom screen’s '
movement and focus on a specific area of the camera’s

field of view. Press the home button in the center of the
control to return the camera to its default home position. v < [1]

Speed- Adjust the camera’s movement speed. Select
from 1-6, default value is 4. < >

Preset- the preset button allows you to go to or setup any
number of presets for the camera. b 4

Preset buttons- __[2]
a. Set current position as a preset.
b. Go to a previously set preset. Speed |4 |w| —

Zoom- Use the Zoom spectrum to zoom in and out and

adjust the camera’s field of view. Click on the left side of Preset 1 —\__[3]
the spectrum line to zoom out of the image. Click on the ——  —

right side of the spectrum line to zoom into a section of U ]
the image. [b]

Focus Control Button- The focus of the camera can be ‘ [a]
controlled by clicking the Focus spectrum line.

Iris Control Button- Iris control button. The iris of the [5]

camera can be controlled by clicking the Iris spectrum
line.

7 e TS 169

[7]
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WEBVIEWER*

Client Setup

It is recommended that you setup your camera’s client settings the first
time you access the camera to prevent any feature malfunction in the
future.

The Client Setup provides options to modify the recording path, streaming protocol and buffering
time. Streaming protocol and buffering time relate to streaming settings for the web Ul on the client
PC. These settings are only applied for the browser session, and don’t persist after the browser is
closed.

Settings apply to a specific PC; they are not universal.

Recording Path

Recording Path is used to define the directory where snapshot images and video will be stored.
Streaming Protocol

RTP/RTSP over HTTP is the default. This is the most flexible setting in that it streams using port 80
which should likely require no client router configuration.

RTP over UDP may use less bandwidth than the other options, but it may also result in inferior video
quality since packets may be lost in transmission (more common over WAN) and may require
additional router client configuration for UDP traffic.

See section 5 Router/Firewall Configuration for more information on network configuration
considerations.

Buffering Time Client Setup
Buffering Time can be increased if video
appears to lag due to network latency.
However, an increased buffer will result in
increased lag between real time.

Recording Path | Select Path |

RTP over UDP
Streaming Protocol RTP over RTSPTCP
@ ATPMATSP over HTTP

Buffering Time 200 (0~1500 ms)

25
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WEBVIEWER*

Setup > System> Information

The Setup interface is primarily used for viewing and configuring the IP
camera’s settings. To access the Setup page, click the Setup link at the
top right-hand corner of the camera’s live display.

. Information
System

Network

s

[

» Video / Andio

» Event Handle Model Name SC250

» PTZ Control Firmware Version 1.1.3 (build 001)

b ST ELTE Serial Number MNo_SerialMum

b Wi-Fi Status Disabled

MAC Address 00:19:6C.EE:00:3E
IP Address 10.1.21.23
Subnet Mask 255.255.254.0
Gateway 10.1.20.250
Primary DNS 10.1.20.96
Secondary DNS 166.95.1921

The camera’s system information will be displayed including:
> Model name

> Firmware Version

> Serial Number

> WIFi Status

> MAC Address & IP Address Information

> Subnet Mask Information

> Gateway Information

> Primary and Secondary DNS Information

To return to the Live View page, click the Live View link in the right hand corner*.

* Configuration changes require clicking the SAVE button. Otherwise, changes will not be applied.

26



WEBVIEWER*

Setup > System> Generic Settings

Use the Generic Settings Page to modify the camera’s Name, Date &
Time format, Sensor Input Type, LED Management, HTTP Port Setup

and Language Selection.

> Camera Name- Enter a camera name if a specific name is desired

» System Time-3 options are available:
> Manual: insert time manually

> PC Time: set to the current PC time
> Network Time Server: periodically synchronizes with a time server
For Network Time Server two standard options are provided. If another time server is preferred,

then choose others from the list and add the address of the time server which will be used.

> Digital Input-This defines the method
by which the digital in sensor operates.
be triggered when the circuit is closed.

The opposite applies for N.C.

27
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v System
Information
Generic Setting
User Account
Maintenance
Local Storage
Recording/Snapshot

Network

v

Video / Audio
Event Handle

v

» PTZ Control
» System Log

Logout

Generic Setting

Camera Name
Camera Name

System Time

Current Time

Synchronize with

Current PC Time
Digital Input

Trigger Status
LED

Power LED
Network LED
IR Light

HTTP Port
HTTP Port
Language

Select Language

Submit

Copyright © 2010 Etro

Netwaork Camera

2013-07-11 14007:21

@ PC Time Manual Network Time Server

@ on off
@ on off

Disable IR lighting at night time

80

English E

Save Cancel

vision Technolagy. All rights reserved.




WEBVIEWER*

bW

Setup > System> Generic Settings

Use the Generic Settings Page to modify the camera’s Name, Date &
Time format, Sensor Input Type, LED Management, HTTP Port Setup

and Language Selection.

> LED- The camera LED lights can be enabled or disabled.
> The bullet model has an additional setting which controls operation of an external IR LED

source.

The External IR Output Level controls the circuit voltage which is used to turn on/off the

external IR LED.

NOTE: Refer to the external IR LED manufacturer’s recommendation to properly set the

External IR Output Level.

Low = Active Low: no voltage turns on the external IR LED; voltage turns off the IR LED

High = Active High: voltage turns on the
external IR LED; no voltage turns off
the IR LED

> HTTP Port- To use a non-default port,
change the HTTP Port value. This port
is used by the camera’s web server
and HTTP streaming.

> Language- Currently English, Simplified
Chinese, Czech, French, German,
Russian and Italian are available.

DWeRinrrnds

v System

Generic Setting

Information
Generic Setting
User Accoun t
Maintenance
Netwaork Camera
Local Storage
Recording/Snapshot System Time

» Network )
Current Time

Synchronize with

2013-07-11 14007:21

» Video/ Audio

@ PC Time Manual Network Time Server

» Event Handle
» PTZ Control
» System Log Digital Input

Logout Trigger Status @ Normal Open Normal Close

LED
Power LED @ on off

Network LED @ on Off

IR Light Disable IR lighting at night time

HTTP Port
HTTP Port 20
Language

English E

Select Language

Submit

\ Save \ | Cancel

Copyright © 2010 Etrovision Technalagy. All rights reserved.
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WEBVIEWER*

Setup > System> User Account Management

User accounts can be added, edited or deleted via the controls in the
left corner.

Users are assigned to a group (admin, operator or viewer).

To edit or delete an account, highlight the account in the User List window and click the edit/delete
button.

After making changes, click SAVE to apply changes.

-
DW.D I GITAL
WATCHDOG Live View
|'I:I|| d Ij E Ij I't D I t User Account Management
E E E v System
User  User  Llser
Generic Setting
User Account
Maintenance Add User *® )
Local Storage User Name Ceaun
Recording/Snapshot Group admin E'
» Network Password
» Video/ Audio
Add Record ® PP B Submit | % Cancel ]
» PTZ Control
D rusty » SystemLog
Logout + 5@ = Page 1 of0 e m view 1-10f 1
Group operator v 3
Canca
Password ssssesss
B Submit x Cancel
A
Copyright © 2010 Etrovision Technology. All rights reserved.
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WEBVIEWER*

Setup > System> Maintenance

bW

Use the Maintenance setup page to upgrade the firmware, Import or
Export Settings, Reset the camera to factory default, or reboot the

camera.

> Firmware Upgrade- The firmware can be upgraded using the web Ul or an SD card. After
upgrading, the ActiveX controls and browser cache should be cleaned to prevent old controls &

pages from being used.

IP and User Account settings can be preserved by checking the appropriate boxes. After
selecting the new firmware file, click Update to proceed. Messages that the camera is
upgrading and rebooting will follow during the upgrade.

Rebooting,please wait

© 3
*«" Upgrading... 57 secs
. W-RETE
Perform the steps in “Clean the
ActiveX and |IE Cache & History” T Maintenance
below, using IP Scan change the
network settings (if applicable), then —_—
check the System Information page to | === m S
verify the upgrade has been - Netwark =
completed successfully. S
» PTZ Control -
e ==

Copyright ® 2010 Etrovision Tachnology. All rights resarva
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Setup > System> Maintenance

Use the Maintenance setup page to upgrade the firmware, Import or
Export Settings, Reset the camera to factory default, or reboot the
camera.

> Firmware Upgrade Using the SD Card- The SD card should be empty of any existing files
before proceeding.

Rename the firmware file to ev-fw.bin, and copy the file to the SD card.
Insert the card into the camera’s SD card slot.
Power on the camera, and wait about 1 minute.

The green power LED will flash quickly during the upgrade, become stable briefly and slowly
blink while performing a reboot.

rwDNE

5. Check IP Scan to verify the camera s

. \ DIGITAL
available (IP address may have DWeRai2inos
changed to factory default, :
v vstem Maintenance
192.168.1.2). S
Generic Setting
6. Remove the SD card. S B rirmvcare upde
7. After web Ul access is once again B e s et Sesing R
available, review the System e -
. . » Video / Audio
Information page to verify the + EventmHandle

upgrade has completed successfully. L rpenmgmse [N

Browse
Logout Import setting from file

Import
Restore Factory Default

Retain IP Setting

Copyright ® 2010 Etrovision Tachnology. All rights resarved.
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Setup > System> Maintenance

Use the Maintenance setup page to upgrade the firmware, Import or
Export Settings, Reset the camera to factory default, or reboot the
camera.

> Clean the ActiveX and IE Cache & History- After upgrading, the ActiveX controls and IE cache
& history should be cleared to prevent old pages and controls from being used.

Close all instances of IE and open 1 IE window.
In the right corner, select Tools->Manage Add-ons
In the Manage Add-ons window, select “All add-ons”

Scroll down and find Unknown Company, highlight one of the ActiveX controls, and click the
More Information link.

hownNPRE

o

In the More Information window, click Remove to clear the ActiveX control from IE.
Repeat this for the remaining ActiveX components.

To clear the cache and browsing history, in the IE menu select Tools->Internet Options. Click
the Delete button in Browsing History.

N o

More Information X

2. B v = v
[t I ol = Page Safety Name: IPSFiter Source 4
Publisher: Etrovision Technology
o ) Type: ActiveX Control
| o Status: Enabled
Version: 4.0.1.0
[t | File date:
=2 POD'UD Blo(ker > Date last accessed: Today, November 01, 2010, 4 minutes ago
Class ID: {543DAD9I1-BOF3-4564-B860-D22F935674EF}
Use count: 528
B Manage Add-ons o =
File: IPSFilter4.ax
Folder: C:\WINDOWS\Downioaded Program Files
% Aork Offline
Marage Add-ons You have approved this add-on to run on the folowing websites:
View and manage your Internet Explorer add-ons 10:teles
Narne Publisher ~
& Toolbars and Extensions | Nothtalatie
£ searth providers Discuss Not Avalible = T [T e o e ST o]
o P R v Bova = 2 =
&\ Research Not Avalable ‘Remove al sites’ wil remove { Sl
£ InPrivate Fitering run on all websites. Browsing history
Microsoft Corporation
A : : g
- ——— S0 4 Delete temporary files, history, cookies, saved passwords,
YML DOM Document Microsoft Corpd ¥/ and web form information.
Windows Media Player Microsoft Corpd|

Delete browsing history on exit

Skype Technologies SA

£33 Skype add-on for Intemet Ex... Skype Technol -
Skype addhon for E Skype Technol (|  Delete... [} Settings

Search

Al add-ons b

il add-ons
(Currently loaded adc-ons
IRun without permission
Downloaded controls
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Setup > System> Maintenance

Use the Maintenance setup page to upgrade the firmware, Import or
Export Settings, Reset the camera to factory default, or reboot the
camera.

> Import/ Export Camera Configuration- Export will save the camera’s configuration settings to
the PC in an archive file.

To import, first use Browse to select a camera’s exported configuration file. Next click Import to
proceed with replacing the current camera settings with the settings in the configuration file.*

> Restore Factory Default- Replaces factory default settings via the web Ul. Network and/or user
account settings can be saved if the corresponding check boxes are selected.

»  Reboot Device- Press the Reboot button to restart the camera. It is recommended to reboot the

camera when major settings have been configured such as after importing settings.
ML SITAL
WATCHDOG b v

v System Maintenance
Information

Generic Setting

Firmware Update

ecord Select Firmware File [ Browse.. |
» Network

» Video/ Audie

» Event Handle

Configuration Export/Import
» PTZ Control

+ System Log Export setting ta file [ Export |

Logout [ Browse.. |

Import setting from file
[(mport |

Restore Factory Default

*Configuration settings can only be B
imported from a camera of the same
model and using the same

firmware version. Otherwise, the
import will apply the factory default
settings.

opyright @ 2010 Etrovision Tachnology. All rights reserved
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Setup > System> Local Storage

The MB950TIR supports local recording to a micro SD Card. Use the

Local Storage setup page to format and setup the card properly.

Format: Format will format the card. Note: contents of the SD card will be lost.
Double click on folders to go up/down a directory level.

SD Card Browser

Statuz: ready / Total: 1944856 KE [ Uzed: 1

629368 KB / Free: 315488 KB

bW

& socard _Move up a directory
(] Folder

[) 20110504_101639_D.avi file

& SD Card
Mame |T',-'3e Size Date Trigger Type
[ picture Folder
£ video Folder
Delete

Download to PC
10203758 2011-05-04 DI

T \

.:E".
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Setup > System > Recording/ Snapshot

There are 2 methods of recording: Event-Triggered and Continuous
Recording. Both can be used simultaneously. Cyclic Recording offers

options for whether to overwrite old recordings when space on the storage

r

>

eaches capacity.

Event Triggered Recording- When recording is done via event triggers, Record Setting will define

how the recording is performed. Stream Source will only display currently enabled video profile

streams.

The pre-alarm and post-alarm buffer are defined in terms of size (MB). The min/max for the
settings are based on the stream’s resolution & bit rate. So, if the stream source is a small
resolution size, then the pre-alarm and post-alarm min/max settings will be less than min/max

values for a high resolution stream.

Continuous Recording- Currently continuous recording only records to SD card. Checking

IWeRaroSs

Recording Schedule will display the
scheduling settings which can be used
to define when continuous recording
should occur.

35

v System

Information

Generic Setting
User Account
Maintenance

Local Storage
Recording/Snapshot
Network

Video / Audio

» Event Handle
PTZ Contrel

» System Log

Logout

Recording/Snapshot

Recording Setting Snapshot Setting

Cylic Recording

Event-Triggered Recording
Enable

Stream Source

Recording Storage

Pre-alarm Buffer

Postalarm Buffer

Continuous Recording
Enable

Stream Source

Recording Storage
Maximum file size

Recording Schedule

Copyright ® 2010 Etrovision Tachnology. All rights resarva
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Setup > System > Recording/ Snapshot

There are 2 methods of recording: Event-Triggered and Continuous
Recording. Both can be used simultaneously. Cyclic Recording offers
options for whether to overwrite old recordings when space on the storage
reaches capacity.

»  Snapshot Settings- Snapshot recording will record a group of snapshots. The maximum value for
Pre-alarm and Post-alarm time is 5 seconds.

Pre-alarm Time 3 ore
Post-alarm Time 3 ore
Snapshot Storage Metwork Storage El
Override Mode i1
Filename: o0

»  Cyclic Recording- The camera can be configured to overwrite the oldest existing recording on SD
Card and Network Storage by checking the appropriate option. Continuous Cleanup will delete the
oldest files as needed when the storage becomes full.
The process will basically delete what is needed for
current recording. SD Card
The Preserve option will delete up to the number of days
defined for this setting. If the storage becomes full and

Recording Setting | Cyclic Recording ‘

| Enable Ovenwrits

@' Continuous cleanup Preserve files in recent day
all the files fall within the X days defined, then recording
will stop. Recording will continue once files are deleted Network Storage
manually or when files become eligible for deletion 7] Enable Overwrite
(greater than X dayS). @ Continuous cleanup Preserve files in recent day
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Setup > Network> |IP Settings

Use the IP Settings page to set the camera to DHCP or Static IP. If Static
is selected, manually enter the camera’s IP address, subnet mask,
Gateway and primary and secondary DNS information.

In the IP Setting tab, select DHCP or Static IP for the camera. If using static, then enter the
appropriate settings for your environment.

Please confirm all network related settings with the network administrator prior to making any
changes.
a. |P Address- Enter the static IP Address of the camera
b. Subnet Mask- default is 255.255.255.0
c. Gateway- your router’s external (public) IP address. It is used when accessing the camera
from outside the network. The router will channel your data to the correct destination even if

it is on a different subnet mask.

d. To obtain a static IP Address and | I eR 00
network information, contact your | o
Internet Service Provider or ifomation
Network Administrator. P
1. DNS- Enter Primary DNS and S o
Secondary DNS. The Domain Name Recording/snapshot I advess 192150100 149
Server translates web addresses to IP || | v s Suer k. 255 255 25
i Gateway 192.168.100.1
addresses. R

» System Log Secondary DNS 168.95.1.2
Logout

| Save ‘ ‘ Cancel

Copyright ® 2010 Etrovision Technology. All rights reserved,
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Setup > Network> WLAN Settings

Only wireless dongles from the manufacturer are supported.
In the WLAN setting tab, click the Enable Wi-Fi option to enable WiFi.

[ ] Enable wi-Fi ® auto Scan ) Manual

Any WiFi changes will only be applied after clicking the Save button in the IP Setting tab.

Auto Scan can be used to scan available networks. An available network can be selected by clicking
the option and entering a password if required.

Manual can be used to directly configure WiFi settings.

EnablelWEr) @ auroscan O wanual Enable Wi-Fi O Auto Scan G Manual
{To submit the settings, please use the Save button in "IP Setting” page.)
— (To submit the settings, please use the Sawe button in "IP Setting” page.) Connect Test
lj” O eripmav_office o (WPA2) nﬂﬂH
:'TJ O Free NKSP-1 m]m.‘ ESSID
j” OrFon_aDDON all "':TJ Security | OPEN »
:'T; O zyxeL 2 (WRA) alll Password
LN L

In the IP Setting tab, set the appropriate IP settings for the wireless network. After clicking Save, the camera
will reboot with the new wireless settings.

The camera will no longer be accessible via the wired network. Disabling WiFi or removing the WiFi USB
antennae will enable the wired network port.
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Setup > Network > Streaming

The camera can stream using UDP, TCP or HTTP. The client application
connecting to a camera can direct which protocol to use. The method of
streaming will likely determine the need and extent of any router
configuration that may be required.

> The port settings all relate to camera ports. If streaming outside of a LAN (e.g. to the internet), then
routers on both the camera and client side need to provide necessary access for these ports.

» The camera will stream via HTTP by default, which will use the HTTP port as defined in the
System — Generic Settings (80 by default). Streaming via HTTP often requires little or no router
configuration.

> If the client application uses RTP over RTSP/TCP, then the camera will stream using the RTSP
Port, 554 by default.

» RTP over UDP will stream using the RTP Video Port, starting at 6002 and can increment .

Enables username/password requirement

URL access name: rtsp://root:pass@10.1.21.3/rtpvideo1.sdp
rtsp://10.1.21.3/rtpvideo.sdp

Authendication
\.—Kcness Mame rtpvideo
RTP over RTSP/TCP

RTsPPot 534 % £ not using default port (554)
RTP Video Port 6002 then port must be included in URL:
Ports used by T T rtsp://10.1.21.3:555/rtpvidec 1.sdp
RTP over UDP RTP Audio Port 6004

RTCP Audio Port R R
Camera audio port to receive

ausoPostPot 1852 4 audio from PC client (e.g. mic)
~—Maximum Viewers 10

Mulficast Streaming -
_-_HH-_"""‘)- Group Address

TL

Limits the number
of cuncurrent connections

To enable multicasting;

Muticasting address enables TTL

<—— _Time To Live
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Setup > Network > Streaming

bW

The camera can stream using UDP, TCP or HTTP. The client application
connecting to a camera can direct which protocol to use. The method of
streaming will likely determine the need and extent of any router

configuration that may be required.

» Video and audio server ports only need be changed if a network has security or operational
restrictions using these ports. In most cases, the RTP/RTCP video and audio should use the

default values.

» While the RTP/RTCP audio/video ports by default are 6002-6005, this represents the starting point
for client connections. If 1 client is connected, then this connection would use 6002-6005, but a
2nd connection would then use 6006-6009. This may require proper router configuration if using

the web Ul outside of a LAN.

» Maximum Viewers refers to concurrent uses. Connections beyond this value will receive an error

upon connection.

» Multicasting allows sending a message or data to a group via a single message. The multicasting

parameters are only for
configuring a camera to use
multicasting. A networking
environment that supports
multicasting must be setup.*

URL access name:
rtsp://10.1.21.3/rtpvideo.sdp
Authentication
\;ccess MHame
RTSP Pori
RTP Video Pori

RTCP Video Port

Ports used by
RTP over UDP

RTP Audio Port

RTCP Audio Port
Limits the number

of cuncurrent connections
~——Pe-Maximum Viewers

Audio Post Port

Muliicast Sireaming
_-_HH-_"""‘)- Group Address

TL

Muticasting address

Enables username/password requirement
risp:/froot:pass@10.1.21.3/rtpvideo1.sdp

ripvideo

554

6002

6004

1852

RTP over RTSP/TCP

If not using default port (554)

then port must be included in URL:
rtsp://10.1.21.3:555/rtpvidec 1.sdp

Camera audio port to receive
audio from PC client (e.g. mic)

-

To enable multicasting;
enables TTL

<—— _Time To Live

* Please contact your network administrator for additional information.
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Setup > Network > DDNS

DDNS is used to map a dynamically assigned IP address (a device using
DHCP) with a hostname.

If the IP camera uses DHCP, a DDNS service can provide a hostname for use with the IP camera.
Registration with a DDNS service provider (ddns.nu, dyndns.org) is required for use of this feature.
1. Touse DDNS, select the Use DDNS checkbox.

2. Select one of the DDNS System Names from the drop down list.
3. Enter Username & Password. The Username & Password must be registered at the DDNS site.
4. Enter Host Name.
5. Click Save to save all changes.
EW"D IGITAL
\/\/ATCHDOG Live View
v System oo
Information
Ceneric Setting
User Accoun t V] Enable DDNS
Maintenance
Local Storage Service Provider dyndns. urgE
Recording/Snapshot Host Name ddnsuser
» Network User Name
» Video / Audio T
» Event Handle
» PTZ Control (Umpw:?te feerva 30
» System Log
Logout @ m

Copyright © 2010 Etro n Technology. All rights reserved.
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Setup > Network > Access Filtering

Access filtering can be used to allow or deny access by IP addresses.

Set the Filter Type to either Allow All or Deny All. Exceptions can be added to the chosen filter type.

IP addresses can be entered as a single IP, by network or a range of IP addresses. The network
option uses the CIDR subnet mask format.

LISITAL
M BUY " VWATCHDOG Live View
T Hwlm Access Filtering
Information
Ceneric Setting
7 .
e e Enable Access Filtering
Maintenance Save,
e S Fiter type Alowall © Denyall
Recording/Snapshot iy
a/snan Allowsd IP address single  [+] Add
» Network
e Allowed Access List
» Event Handle
» PTZ Control
» System Log
Logout
Copyright © 2010 Etro n Technology. All rights reserved.
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Setup > Video / Audio > Video Settings

Use the Video Settings page to select the number of profiles the camera
will stream simultaneously and setup each of the profiles.

> Power Frequency- Use this setting to adjust the camera’s display has flickering issues. This may
occur due to artificial lighting and can be adjusted by modifying the Power Frequency. Select from
50GHz or 60GHz.

»  Max Resolution- Select the camera’s resolution. By default, the camera is setup to 1080p (2.1
Megapixels). The higher the resolution, the lower the maximum frame rate will be (for example,
the camera can stream up to 10 fps on 5 Megapixel resolution).

» 1 to 5M (2592x1920) with a maximum 10fps for both Stream 1 and 2.
> The 5M option limits ROI to 2, and recording via the camera (e.g. SD card) is disabled.

> Minilux mode uses noise cancelation technology to provide clearer image quality in low lux
conditions.

»  Enable TV Output- TV Output can be
enabled with SDTV or HDTV options
available. T s

> SDTV = CVBS output
> HDTV = YPbPr output

When TV Output has been enabled, 2 n
video profiles will be enabled. Profile 2 > Video/ Audia
will change to settings which will be —
used for the video out display (e.g. D1
resolution). Profile 1 settings will not be :

modified. s i

» Show/ Hide Time Stamp & Camera
Name- When enabled, the video will
display the time stamp and camera
name at the top left-hand corner of the
display area.

Video Setting

Fower Frequency ® GoHz SO0Hz

Max. Resolution SMP L) 3MP @ 1080p 1.3MP ) Minilux(720p)
Enable TV output

V| Show time stamp and camera name on video

Profile Mode

1 Profile @ 2 Profile 4 Profile

Quality Setting

| save | [ cancel

* Option not available on DW

Optimized Firmware
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Setup > Video / Audio > Video Settings

Use the Video Settings page to select the number of profiles the camera
will stream simultaneously and setup each of the profiles.

> Profile Setting- The Video Profile Settings control the ROI (Region of Interest) characteristics. The
ROI video is streamed via RTSP protocol. See the “Streaming ROI” section for more on viewing
ROI video.
The number of available ROI profiles for viewing can be set by selecting the appropriate option
button.
4 Profile defines each stream with a VGA resolution (640x480), while 1 Profile and 2 Profile
settings provide some options for resolution.
Settings for specific ROI profiles can be found in the Video Quality Setting section.
ROI profile 1 & 2 are preconfigured profiles which have some settings that are configurable (e.qg.
FPS).
All profiles offer Constant Bit Rate (CBR) or Variable Bit Rate (VBR) mode.
The GOP (Group Of Pictures) can also be adjusted. The GOP is based on the FPS setting. For
example, if the FPS is 20 and the GOP setting is 2, then the GOP is 40 frames. A GOP is
comprised of one | frame and the remainder are P frames.
4 Profile defines each stream with a VGA resolution (640x480). In the Region Size settings, the
image has a mask covering area that will not be displayed; the lighter shaded area will be what is
displayed for the ROI. To adjust the ROI, click & drag the window or click within the

masked area to reposition. e

Encode Type ® H264 O mpeca O MmppeG

Region Size 640x480 VGA v

X-axis Y-axis Width | Height

Preferred Bitrate / Frame Rate

Bitrate Control CBR v

Max Bitrate 256K (v

Max Frame Rate |20fps v

* Option not available on DW Optimized Firmware
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Setup > Video / Audio > Audio Settings

Select the desired audio codec. The Bitrate is configurable for some
codecs.

> Encoder Type-Select from the available options: NONE, AAC, G.711 u-law (default), G.711 a-law ,
G.726.

> Bitrate- If AAC or G.726 are selected as encoder type, setup the bitrate. Select form 16, 32, or 40
Kbps.

> Line-in Gain- Adjust the volume of input audio from 0 to 10. Default value is 6.
> Line-Out Gain- Adjust the volume of output audio from 0 to 10. Default value is 6

IWeRaerods -

Audio Setting

Encode Type G.728 [~]

Bitrate 32Kbps[+]

o
8
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Setup > Video / Audio > Color Settings

Use the Color Settings to adjust the Day/ Night Settings as well as image
color control settings.

> Day/Night Settings: IR Cut Filter

> The Auto Mode (AE) allows adjusting the light sensor’s sensitivity to day/night conditions to
fine tune the IR cut filter operation when the Auto Mode (Light Sensor) isn’t optimal for a
specific environment.

> In Transfer Threshold are 2 settings: From Day to Night and Back to Day.

> From Day to Night has a range (+10 Bright to -10 Dark) which can be used to adjust the
sensitivity of switching from day to night. A larger From Day to Night value will result in a
switching to Night mode in lighter conditions, a lower value requires darker conditions to
switch.

> Back to Day also provides a range (+2-+12) which adjusts the sensitivity of the switch from
night to day. This value relates to the From Day to Night; the switch to day mode is based
on the From Day to Night + Back to Day values.

> NOTE: Auto Mode (AE) doesn’t differentiate between IR light and visible light. Subsequently,
IR light can cause the IR-Cut filter to switch back to Day mode.

> While in night mode, if an object is close the image will appear bright from the IR light and
result in the Luminance Metering to register a high value which can switch the camera back to
Day mode. This is due to Auto Mode (AE) using image brightness.
So, the camera shouldn’t use this setting in environments where objects are close creating a
“bright” image. Alternatively, set the Back to Day to a high value to counteract this behavior.

Day/Night Setting

IR-Cut Filter Auto Mode (AE) [=]

Transfer Threshold From Day to Night D[Nﬂrmal}-E back to Day | +3 E
Luminance metering :

B/W in night mode
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Setup > Video / Audio > Color Settings

Select the desired audio codec. The Bitrate is configurable for some
codecs.

> Color & Sensor Settings: Image settings for both day and night are available via the Day & Night
Time Profile tabs. The relevant settings will be applied to the camera based on the camera’s
present mode of operation (e.g. day or night). In the Color Settings Tab, adjust the following
options:
> Brightness: select values from 0~255. Default value is 128. The higher the number the brighter
the image will appear.

> Contrast: select values from 0~255. Default value is 128. The higher the number the stronger
the contrast between the dark spots and bright spots in the image will appear.

> Saturation: select values from 0~255. Default value is 128. The higher the number the warmer
the colors in the image will appear.

»  Sharpness: select values from 0~255. Default value is 100. The higher the number the sharper
lines in the image will appear.

> Flip: flip horizontally (top to bottom) Day/Night Setting
> Mirror: flip vertically (right to left) IR-Cut Filter Auto Mode {Light sensor) ]
BANY in night mede v
Day Time Profile MNight Time Profile
Color Setting

Color Setting

Brightness

Contrast

Saturafion

Sharpness

Flip Image

Mirror Image
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Setup > Video / Audio > Color Settings

Select the desired audio codec. The Bitrate is configurable for some
codecs.

»  Color & Sensor Settings: Image settings for both day and night are available via the Day & Night

Time Profile tabs. The relevant settings will be applied to the camera based on the camera’s
present mode of operation (e.g. day or night). In the Sensor Settings Tab, adjust the following
options:

bl

AE Range Limit: enabling exposes an upper/lower limit list of exposure values for configuration
Enabling also disables AEC & AGC settings and hides the setting controls

AEC: Automatic Exposure Control; disabling enables Manual Exposure
Max Exposure: maximum possible exposure time
Manual Exposure: sets specific exposure time

AGC: Automatic Gain Control; disabling enables Manual Gain
Max Gain: maximum possible gain
Manual Gain: sets specific gain setting

AWB: Auto White Balance. Day/Night Setting
Location: indoor/outdoor setting to provide IR-Cut Filter Auto Mode (Light senson) [+
more accurate exposure for an indoor or B/W in night mode ~

outdoor environment.

BLC: Back Light Compensation; image EV
(Exposure Value) can be increased to | S R

compensate for background lighting.

Color Setting

WDR: Wide Dynamic Range; used for high

. . Sensor Setting
contrast lighting; some camera models only have e g ot
Medium and High setting. e .
Noise Reduction: image noise compensation; manual WMax Exposure 1/30 (] Manual Exposure
allows user to define level of noise reduction ace v
(O none, 255 max). Max Gain| 32 [*] Manual Gain
While noise reduction will smooth pixilation (usually in A8 R
dark areas), too much may result in blurring. oczten rdoor [7]
BLC Disable [+ ]
WDR Disable []
Moise Reduction Auto [7]
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Setup > Video / Audio > Text Overlay

The video display format can be changed by selecting one of the
available timestamp formats and enabling display of the camera name.

> Select from the following available text display options:
> yyyy-mm-dd hr:min:sec
> mm-dd-yyyy hr:min:sec
> mmmm-dd-yyyy hr:min:sec

» Choose to enable or disable attaching the camera’s name to the text overlay.

IWeRaerods

Text Overlay

v System
Information

Ceneric Setting

Maintenance
Local Storage
Recording/Snapshot

Network

v

v

Video / Audio
» Event Handle
» PTZ Control
» System Log

Logout

Copyright ® 2010 Etro

User Account Timestamp Format | YYYY-WM-DD HRMIN:SEC [+]

Attach camera name to the caption

Save Cancel

vision Technology. Al rights reserve

d.

Live View
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Setup > Video / Audio > Privacy Masking

Privacy mask can be used to block out areas from view and triggering
motion detection. Up to 5 privacy masks can be applied; each mask can
be 80 x 45 in size.

Check the box next to the Privacy Masking you want to edit.

Check the Draw button next to the Mask’s name.

Select the color of the mask you want to setup (black by default).
Using your mouse, draw the mask on the camera’s display window.

Use the block’s handles to adjust the size or move the mouse over the area and click/drag to
move the mask.

You can also use the X/ Y/ W/ H values to manually adjust the position and size of the mask.
The masked area will be blocked from the image (and motion detection) with the color set in Color

ok wbdRE

N o

of Mask. ;
DW.D ISITAL
WATCHDOG Live View

v System Privacy Mask
Information

Ceneric Setting
User Accoun t
Maintenance
Local Storage
Recording/Snapshot
» Network
» Video / Audie

» Event Handle
» PTZ Control
» SystemLog Color of Mask Black [~]

Logout
Mask Window

Mask Window

O] Mask Window

= i35 3 =
T T T I =T

1
2
[ Mask window 3
4
5

[7] mask wincow

Copyright ® 2010 Etrovision Technology. All rights reserved,
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Setup > Event Handle> Event Rule

The Event Rule page is used to define actions (e.g. record to SD card) in
response to the triggering of an event (e.g. motion detection).

> Rule Name is a user defined name for a user defined trigger/action.
» Trigger Type- select what action will trigger the set command. Select form the available options:

» Motion Detection — Set action will be activated when the camera detects motion. If selected,
check which motion areas will apply to this rule. See page 52 for information on how to setup
motion detection.

» Digital Input —Set action will be activated when the camera detects a sensor is activated. Select
which sensor you want to setup as the trigger to the rule.

» Network Loss — Set action will be activated when the camera detects network loss.

» Periodical Times — Set action will be activated every set amount of seconds. Default time is set
to every 60 seconds.

> Period Time is a time interval during W2 2L L84
which an event cannot be triggered. For
example, if Period Time is set to 60, then || " .. gy
after a specific event is triggered (e.g. o s
motion detection), that event can only be
triggered after 60 seconds. R,
This applies only to a user-defined e =1
event. If 2 motion detection events have | » s m—
been configured (e.g. MD1 and MD2), .+ Systemiog
then if MD1 is triggered, MD2 can still be || ™" i
triggered regardless of MD1’s Period
Time setting. i

DerecrAea areal [ area2 [ Areas

Period Time 1

Action
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WEBVIEWER*

Setup > Event Handle> Event Rule

The Event Rule page is used to define actions (e.g. record to SD card) in
response to the triggering of an event (e.g. motion detection).

» Action determines what action you would like the camera to perform once the selected trigger has
been detected. Select from the following options:
» Digital Output — The camera will activate the digital output when the trigger set is detected. The
Digital Output option has a Duration parameter which relates to the length of time the digital
output should be triggered.

» E-mail Notifications — The camera will send an e-mail notification to a set destination when the
trigger set is detected. See page 53 for more information on setting up e-mail notifications.

» TCP Notification and HTTP Notification — The camera will send a TCP or HTTP Notification to a
determined server when a selected trigger is detected. These notification options have a
Message Text box where you can enter what text you would like to be sent with the notification

(Max 32 characters).

DIGITAL
» Snapshot — The camera will send a DWeRnicrooe
snapshot image to a network storage + System e
when the trigger selected has been S
detected. The Snapshot will include a e
total of three images: a Pre-Alarm e
snapshot (3 seconds before the o .
alarm), the alarm snapshot, and a L
post-alarm snapshot (3 seconds after | - — S
the alarm). See page 36 for

information on the snapshot settings.

» Please note that available actions
depend on the trigger type. For example, G
you will not be able to select to send an B
e-mail notification on network loss.

» Click SAVE in the main Event Rule o v Roifeation
screen to save any changes.

Trigger Type Network Loss
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WEBVIEWER*

Setup > Event Handle> Event Server

The Event Server page has configuration options for event notification &
action using email, network storage, FTP, TCP and HTTP.

> E-Mail Settings — Use this setup page to enter the information for an SMTP server for the e-mail
notifications feature.

» Enter the SMTP server for Server Address and all additional relevant details.

» The username may only contain alphanumeric characters and the underscore character, “
» Use the ‘Test’ button to send a test e-mail to make sure the server has been properly set up.
» Select whether the e-mails sent from the camera will have event information in the message.

» Select to customize the e-mail’s default message. You can use this option to personalize the e-
mail messages sent from the camera.

» Enable or disable snapshot attachments with event notifications to e-mails sent from the
camera.

({3

v System Event Server

Information

Generic Settin
g Email Setting Network Storage FTP Server TCP/HTTP Recipient

User Account

Maintenance .
server Information

Local Storage

T R Server Address smtp.mymail.com

+ Network Server Port 25

» Video / Andio Require Authentication

» Event Handle e nan e

» PTZ Control Password

» SystemLog Sender email address user@smtp.mymail.com

Logout Recipient email address user@smtp mymail com
Connection Timeout (sec) 5
require TLS/SSL conne: ction
Connection Test Test

Message Content
7| Indicate event information in message body

User-customized message (300 characters)
Mail Attachment

Artach snapshot with event notification

Save Cancel

Copyright ® 2010 Etrovision Technology. All rights reserved,

IWeRaerods -
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WEBVIEWER*

Setup > Event Handle> Event Server

The Event Server page has configuration options for event notification &
action using email, network storage, FTP, TCP and HTTP.

» Network Storage— Use this setup page to enter set up a Network Storage device.
» Server Type- Select whether the network storage you want to setup is NFS or Samba.
» Server Address- enter the server’s URL or IP address.
» Folder Path- enter the folder destination in the network storage where you would like all
notifications from the camera stored.
» Username and Password- enter the username and password for the server.

» Connection Status- indicates whether the connection between the camera and the server is
available or not. Press the ‘Refresh’ button to make sure the camera is successfully connected
to the server.

LISITAL
W WATCHDOG Live View
v System

: Event Server

Information

Ceneric Setting

Email Setting Network Storage | FTP Server TCP/HTTP Recipient

User Account

Maintenance V| Enable Netwark Starage

Local Storage Server Type NFS E

Recording/Snapshot
Server Address LOCALHOST

Network

Folder Path PATH
Video / Audio

» Event Handle USERNAME

» PTZContrel ~  Password  esssssss

» SystemLog Deattached | Refresh |

Logout

| save | | cancer |

Copyright ® 2010 Etrovision Technology. All rights reserved,
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WEBVIEWER*

Setup > Event Handle> Event Server

The Event Server page has configuration options for event notification &
action using email, network storage, FTP, TCP and HTTP.

» TCP/ HTTP Recipient— Use this to setup the recipients for TCP and HTTP Notifications from the
camera. The TCP and HTTP Recipient allows event notifications to be sent from the camera to a
TCP or HTTP server. A triggered event will use the settings defined in TCP/HTTP Recipient to
send a notification to the TCP or HTTP server. The notification will include any message text that
was defined in the Event Rule. See page 39-40 for more information.

» TCP Recipient requires an IP address and port for the server which will process the notification
via TCP socket.

» TCP Server Address & port- enter the server’s URL or IP address and port information for the
TCP Server.

» Connection Test- Use the ‘Test’ button to make sure the proper information has been saved on

the camera and it is properly e
connected to the TCP Server. DWeRsieroos s

» HTTP Recipient requires an HTTP + System Sl
server URL along with credentials S
which will process the notification sent | ="

Via HTTP eelteeae Server Address 192.168.1.1

» HTTP Server Address- enter the > Netwark ComectonTess [ Teat]
server’s URL or IP address and port  EventHandle
information for the HTTP Server. :

» Username and Password- enter the oo ]
username and password for the server. (Saie] [Cancei

» Connection Test- Use the ‘Test’ button
to make sure the proper information
has been saved on the camera and it
is properly connected to the HTTP
Server .

Email Setting Network Storage FTP Server TCP/HTTP Recipient
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WEBVIEWER*

Setup > Event Handle> Motion Detection

To use motion detection, motion detection should be enabled and at least
one motion detection area enabled. Checking the box for an Area (e.g.
Area 1) enables it.

» Make sure “Motion Enable” is checked.

» The camera supports up to three (3) different motion detection areas. To set them up:
» Select an area by checking the box next to it.

» Click on the ‘Draw’ button.

»Using your mouse, draw the zone on the camera’s display window.

» Use the block’s handles to adjust the size or move the mouse over the area and click/drag to move
the motion zone.

» You can also use the X=horizontal, Y=vertical, W=width, H=height values to manually adjust the

position and size of the motion zone.

» Set the camera’s sensitivity to the DWeRneinos
motions. Select from a scale of 0 to 100; | Motion Detection
default is 50. The lower the number the information
less sensitive the camera will be to e
motion. s
> Object size determines the size of an | e
area that will trigger motion detection. Ve s
The value represents percentage of the Q—
motion detection area which will result in || > o
motion detection. Select from a scale of ’
0 to 100; default is 25. ow X0 YO wi a0

Object —
size — 2

Copyright ® 2010 Etrovision Technology. All rights reserved,
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WEBVIEWER*

Setup > PTZ Control > Serial Settings
PTZ settings can be applied if the camera will interact with a PTZ device.

> Pelco P and D and transparent protocols are supported as well as RS-485 and RS-422
communication modes.

» Please refer to the PTZ device’s required settings to configure the web Ul PTZ settings.

DW’D IGITAL
WATCHDOG Live View
» System Serial Setting
Information

Ceneric Setting

[Lafee PTZ Protocol None [+]
Maintenance N
Device ID 1
Local Storage
Baud Rate 2600 [+]
Recording/Snapshot
» Network Data Bits g Iz‘
+» Video/Audio Parity Bit none [~
» Event Handle Stop Bits 1[=]
» PTZControl Communication Mode |RS485[< ]
» System Log
Logout Save

Copyright ® 2010 Etrovision Technology. All rights reserved,
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WEBVIEWER*

Setup > System Log > View Log

The System Log displays system and event details.

» The System Log has information specifically related to basic system messages (e.g. startup,

shutdown)

» Event Log contains information related to events triggered.
» You can click the ‘Refresh’ button at any time to upload the latest and most up to date log report.

D LISITAL
WATCHDOG

“

System

Information ‘
Ceneric Setting

User Account

Maintenance

Local Storage
Recording/Snapshot

Network

v

Video / Audio

v

Event Handle

L3

PTZ Control

v

v

System Log

Logout

View Log

System Log EventLog

Jul 1z 08:04 ips_e3a2[841Z]
Jul 12 08:05 ips_e3az[8412]
Jul 12 08:05 egi-ns[1621%
Jul 12 08:0% egi-ns[1621%
Jul 12 08:0% ips_e3a2[8412]
Jul 12 08:05 ips_s3a2[8412]
Jul 12 08:0% ips_e3a2[8412]
Jul 12 08:0% ips_e3a2[8412]
Jul 12 08:06 ips_e3a2[8412]
Jul 1z 08:06 egi-ns(1

Jul 12 08:06 ips_e3az[8412]
Jul 12 08:0§ egi-ns[16213
Jul 12 08:06 ips_e3a2[8412]:
Jul 1z 08:06 ips_s3a2[8412]
Jul 12 08:06 ips_e3az[8412]
Jul 12 & ips_e3a2[8412]
Jul 12 08:07 ips_e3a2[8412]
Jul 1z 7 egi-ns (16227
Jul 12 08:07 egi-ns[16223]-
Jul 12 7 ips_e3a2[8412]
Jul 12 08:07 ips_e3a2[8412]
Jul 12 7 ips_e3a2[8412]
Jul 1z 7 ips_e3az[8412]
Jul 12 8 ips_e3a2[8412]
Jul 12 8z ips_e3a2[8412]
Jul 12 8 egi-ns[1623L
Jul 12 08:08 egi-ns[16227]
Jul 12 08:08 ips_e3a2[8412]
Jul 12 08:08 ips_e3a2[8412]
Jul 12 08:08 ips_e3a2[8412]
Jul 12 08:0% ips_s3a2[8412]
Jul 12 08:0% ips_e3az[8412]:
Jul 12 08:0% egi-ns[1623%
Jul 12 08:0% cgi-n=[16231]:
Jul 1z 08:0% ips_s322[8412]

Copyright ® 2010 Etrov

[FF_SendDnReloadlrig] 0130712080457
[BF_SendDnRelsadTrig] 0130712030510

nosification stream connected from 192_1€8.100.200

netification stream disconnected from
[FF_SendDnReloadTrig] 2013071208051%
[EF_SendDnRelsadTrig] 0130712030532
[BF_SendDnReloadTrig] 20130712080541
[PF_SendDnReloadTrig] 2013071203085%
[FF_SendDnReloadTrig] 20130712080803

notification stream connected frem 192.168.100.200

[BF_SendDnRelsadTrig] 20130712030815
netification stream disconnected from
[FF_SendDnReloadTrig] 20130712080624
[BF_SendDnRelsadTrig] 0130712080837
[EF_SendDnReloadTrig] 20130712030848
[BF_SendDnReloadTrig] 2013071203085%
[FF_SendDnReloadTrig] 20130712080708
notification stream connectad from 19

notification stream disconnected from
[BF_SendDnReloadTrigl 20130712080721
[PF_SendDnReloadTrig] 20130712030730
[FF_SendDnReloadTrig] 0130712080743
[BF_SendDnRelsadTrig] 20130712030753
[BF_SendDnReloadTrigl 20130712030805
[PF_SendDnReloadTrig] 20130712030814

notification stream connected from 192.168.100.200

notification stream disconnected from
[BF_SendDnReloadTrigl 20130712080827
[PF_SendDnReloadTrig] 2013071203083&
[FF_SendDnReloadTrig] 2013071208084%
[EF_SendDnRelsadTrig] 0130712030300
[BF_SendDnReloadTrig] 20130712080311

notification stream disconnected from
[BF_SendDnRelsadTrig] 0130712080320

on Technology. All rights reserved.

Sned RELOAD=L
Sned RELOAD=2

182.1828.100.2
Sned RELCAD=1
Sned RELOAD=2
Sned RELOAD=1
Sned RELCAD=2
Sned RELCAD=1

Sned RELOAD=2
182.1828.100.2
Sned RELCAD=1
Sned OAD=2
Sned RELOAD=1

152_.188.100.2
Sned RELOAD=2

Sned RELCAD=1 E
Sned RELCAD=Z
Sned RELOAD=1

Sned RELOAD=2

notification stream connected from 192.1§2.100.200 (2/§).

152.168.100.200 (1/5) -
Sned OAD=1 E

Refresh
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WEBVIEWER*

Setup > System Log > Remote Log Settings
The System Log displays system and event details.

» The System and/or Event log data can be sent to another server. The syslog service is used to
send the message data, and the camera will use UDP port 514 (syslog protocol) to transmit the
data.

» The remote server which will receive messages must have an application which will receive and
manage the syslog messages. If using Windows, an application such as Kiwi Syslog Server or
Splunk can be used to receive and manage the data.

» To enable remote logging,:

» Check the Enable box ML ' SITAL
, , WUV " WATCHDOG .
» Provide the corresponding log server
|P addreSS. v T:St::luﬂ Serial Setting

GCeneric Setting
User Account PTZ Protoco | None =
Maintenance

Local Storage
Baud Rate 2600 [=|

» Network Data Bits 3[]
» Video/ Audio Parity Bit none [«
» Event Handle Stop Bits 1[=]

» PTZ Control Communicat tion Mode | RS485 [+
» System Log

Recording/Snapshot

Logout \ Save |

* The remote server’s firewall or a router may block incoming UDP syslog traffic from the camera.

If the remote server’s monitoring application is not receiving message data from the camera,
verify the router or firewall are not blocking incoming traffic.
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SPECIFICATIONS*

IMAGE

Image Sensor

1/2.5” 5SMP CMOS Sensor (20% Larger Than 1/3” CMOS Sensor)

Total Pixels

2016 (H) x 1108 (V)

Minimum Scene lllumination

0.0 Lux

Lens 3.4~10mm Varifocal DC Iris Lens

Optical Zoom 3x Optical Zoom

IR Distance 80ft Range IR with Intelligent Camera Sync
Angle of View Horizontal: 40 (wide) - 25 (tele)

AUDIO

Compression and Sampling Rate

G.711/ G.726/ AAC

Input/ Output
OPERATIONAL

DNR (Digital Noise Reduction)

1x Line In and 1x Line Out

Off, Auto, Manual (0~255)

Auto Gain Control

2x~128x, Max Gain, Manual

BLC (Back Light Compensation)

-2.0EV ~ +2.0EV, Off

WDR (Wide Dynamic Range)

Off, Low, Medium, High

Day and Night

Auto, Day (Color), Night (B/W) , Activate with Digital Input

Brightness

0~255

Alarm Notifications

File Upload via FTP and E-mail, E-mail Notifications with Snapshot attachment, External Output
Activation, File Recording to SD Card, Remote FTP or NAS

Sharpness 0~255
Mirror & Flip Off/ On
Memory Slot 24 hours recording to Micro SDHC Card (4GB-32GB) *Card not included

Recording Schedule Setup

Continuous, Event, Pre- & Post-Alarm Recording to SD Card, FTP Server, and Network Storage

Chroma (Hue & Saturation Settings)

0~255




SPECIFICATIONS*

NETWORK

LAN

DW Optimized Firmware

802.3 Compliance 10/100 LAN

Full Firmware

Video Compression Type

H.264

H.264, MPEG4, MJPEG (Super Fine ~ Low)

Resolution

10fps @ 2560x1920 (5MP)

@2592x1920(5MP) / 20fps@2048x1536(3MP)
/ 30fps@1920 x1080(2MP)

Frame Rate

Up to 10fps

Up to 30fps based on Resolution

Stream Capability

Dual-Stream at Different Rates and Resolutions

P

IPv4, IPV6

Protocol

TCP/IP, HTTP, DHCP, PPPoE, HTTPS, ICMP, ARP, RTSP, NTP, UDP, NTP, SMTP, RTP,

RTCP, 3GPP, SAMBA (NAS)

Maximum User Access

10 Users

Memory Slot

Local SDHC Card Backup- 24 hours recording to Micro SDHC Card (4GB-32GB)

ONVIF Conformance

Yes, Profile S

Web Viewer

Supported OS: Windows XP, Windows Vista, Windows 7, MAC OS
Supported Browser: Internet Explorer 8 or higher, Google Chrome, Mozilla Firefox, Safari

Video Management Software

ENVIRONMENTAL

DW Spectrum

Operating Temperature

-40°C ~ 60°C (-40°F ~ 140°F)

Operating Humidity

Less than 80% (Non-Condensing)

Storage Temperature

-29°C ~ 55°C (-20°F ~ 131°F)

IP Rating

IP67 (Vandal Proof, protects against dust & high pressure water)

Other Specifications

Electrical

CE, FCC, RoHS

Power Requirement

DC 8~25V, AC 24V, PoE (IEEE802.3af Class 3)

Power Consumption

Mechanical

Max 8.9W, 600mA

Housing Material

Aluminum Housing

Dimensions

95(W) x 95(H) x 251(D)mm (3.74 x 3.74 x 9.88 Inch)

Weight

3.97 Ibs




TROUBLESHOOTING

bW

Before sending your camera for repair, check the following or contact your technical specialist.

Streaming video from the camera using an RTSP Streaming.

AUTHENTICATION

Video can be streamed to a video player (e.g. VLC) via RTSP protocol using the standard RTSP port number
554,

The URL is in the following format:

rtsp://[IP ADDRESS]/rtpvideo[1-4].sdp

Replace with the appropriate IP address.

rtpvideol-4 represent video profiles with different characteristics. For more information on video profiles, see
Video/Audio > Video Setting”.

Using VLC for example, select Media from the menu bar
and Open Network Stream.

Next specify IP address of the camera and stream profile.
Click Play and video will begin streaming in the video
player.

WARNING: firewalls and other network security may
prevent video streaming.

£ VLC media player
Playback  Audio
[¥] openFile... Ctrl+0 : )
[¥] Advanced Open File... Ctrl+Shift+0
(C] Open Folder... Ctrl+F
(o) Open Disc... Ctrl+D

e
— Open Metwork Stream. . Chrl+n

Video

Tools View Help

Open Capture Device. ., Chrl+C
N [ em ‘
(CJEle | (2dpisc | “& Metwork Capture Device
Metwork Protocol

Protocol Address Port

RTSP % |10.1.21.40/rtpvideo2.sdp lo

. L . . retwiork Protocol
If Streaming authentication has been enabled in Network -> Streaming FROrE FrEtee

Then a username/password must be supplied with the RTSP URL Please enter a netwark URL:

rtsp://USERNAME:PASSWORD@IIP ADDRESS]/rtpvideo[1-4].sdp ttspfrootipass@10. 121,56 tpvideod .sdp]
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TROUBLESHOOTING

Before sending your camera for repair, check the following or contact your technical specialist.

Viewing Motion JPEG from the camera in a Browser

= Basic streaming from the camera to a browser can be done using the mjpg.cgi call.
= Microsoft IE does not support this function. IE doesn’t support the server-push implementation, so Firefox is
recommended for use with mjpg.cgi. Other browsers (e.g. Chrome) may also work.
= First, configure the target video stream profile to use MJPEG encoding type. If multiple video profiles use
MJPEG, then the profile parameter should also be included; this is discussed below.
Profile 2
Encode Type H.264 MPEG4 '@ MJIPEG
" In the browser enter the mjpg.cgi call. Substitute the camera IP/URL for <IP ADDRESS>:
" http://<IP ADDRESS>/stream/mjpg.cgi
] The user will be challenged for a username and password; this is required and can’t be disabled.
" The username/password can be included with the URL avoiding the username/password pop-up window. Use

the following format (substitute root:pass with appropriate username:password):
" http://root:pass@<IP ADDRESS>/stream/mjpg.cgi
" If multiple profiles are using MJPEG codec, then the profile=n parameter should be included to specify which
video stream profile to use. Substitute the stream profile number (e.g. profile=2 for camera video profile 2) for n:
" http://<IP ADDRESS>/stream/mjpg.cgi?profile=n
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TROUBLESHOOTING

Before sending your camera for repair, check the following or contact your technical specialist.

Digital Input Electrical Information

= Ambient Temperature: 25° C
= TTL signal only
= External voltage source: 3-5vVdc £10%
= TTL signal high/low level: 3.3V
] Max. current: 20mA
DC Power
DO +
£\
Camera/ C \J
Encoder

o,
)

1DO -
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TROUBLESHOOTING

Before sending your camera for repair, check the following or contact your technical specialist.
Digital Output Electrical Information

Ambient temperature: 25° C

External power input: < 12Vdc

Continuous load current: 100mA

Peak load current: 240mA (100ms / 1 shot)

DC Power
@)

DO +

Camera/
Encoder

O
O

O

Q

DO -
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Before sending your camera for repair, check the following or contact your technical specialist.

I can’t find my MEGAPIX camera on the IP Finder software.

Is the PoE cable connected properly?

Make sure the cable is tightly connected at both ends. It should make a “click” sound when connected properly.
Make sure the cable is intact and there are no cuts or exposed wires.

If Yes, are the camera’s LED lights turned on and blinking?

The camera’s LED lights indicate that the camera is powered on. Blinking LED lights indicate that the camera
has finished booting up and is transmitting data.

If Yes, is the internet working properly?

Make sure you can connect to the internet with other devices on the network (ex. Your Computer). Your internet
could be temporarily down.

If Yes, if using a power adaptor, does it meet camera’s power requirements?

Power Requirements: DC12V (5.16W, 430mA), PoE Ports (Class 2, less than 7W)

If Yes, if using POE Switch, is it connected to a proper internet outlet and operating properly?

Make sure the PoE Switch is connected to a router/modem and the ports that have devices connected to them
have a green LED on.

If Yes, is the computer on the same network as the MEGAPIX camera?

Camera and computer should be connected to the same router. Contact your network adminitrator if you have
more than one network available.

If Yes, try pinging the IP camera’s default IP address 192.168.1.123

From your desktop, go to Start > Programs > Accessories > Command Prompt. Type “ping 192.168.1.123” and
press Enter. If you get the message “Request timed out,” cmaera is not connected. Camera is connected if you
get data.

If Yes, try connecting the camera to a differt port in the PoE Switch.

That specific Switch Port may be damaged or currently not working properly.

If Yes, try resetting the camera to default settings.

Press the 2 buttons in the back together and hold for 5 seconds. The camera will return to factory deafult with
default IP address 192.168.1.123. If your network supports DHCP, the camera will be found using the IP Finder
software with an IP address that matches your network’s requirements.
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Before sending your camera for repair, check the following or contact your technical specialist.

I can’t connect to my MEGAPIX camera through the Web Browser

Are the camera’s LEDs on and blinking?

The camera’s LED indicates the camera is On. If the LED blinks, the camera has finished booting up and is
transmitting data.

If Yes, is the internet working properly?

Make sure you connect to the internet with other devices on the network (ex. Your Computer). Your internet
could be temporarily down.

If Yes, is the computer on the same network as the IP camera?

Camera and computer should be connected on the same router. Contact your network administrator if you have
more than one network available.

If Yes, try pinging the MEGAPIX camera’s IP address as it appears on the IP finder.

From your desktop, go to Start > Programs > Accessories > Command Prompt. Type “ping” followed by the
camera’s |IP address; then, press Enter. If you get the message “Request timed out,” camera is not connected. If
you get data back, that means the camera is connected.

If Yes, try connecting the camera, to a different port in the POE Switch.

That specific Switch Port may be damaged or currently not operating properly.

If Yes, check your security settings on your internet browser.

Try adding the camera’s IP address to the trusted sites list in your Internet Options. *Setup may vary depending
on the browser you use.
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Before sending your camera for repair, check the following or contact your technical specialist.

Il can’t see the live video of my MEGAPIX camera.

Are you trying to view the camera’s video from an Internet Explorer browser?

Make sure you have the minimum PC requirements to view the MB950TIR camera. *See below for more
information.

If Yes, did you install ActiveX files?

When you connect to your MEGApix camera for the first time, your browser will ask you to install ActiveX. Make
sure your Web Browser’s security settings do not block pop-up windows and allows ActiveX files to be installed
and used. *Setup may vary depending on the browser you use.

If Yes, make sure nothing is blocking the MB950TIR camera’s lens.

Are you trying to view the camera’s video from a different browser than Internet Explorer (ex. Google Chrome,
Mozilla Firefox, MAC Safari)?

If Yes, at least one of the streams of the camera must have Codec set to MJPEG.

Go to the camera’s setup menu. Select Stream Settings. Select one of the streams and change its codec to
MJPEG. Click Save and Reload to save changes. Go back to live screen and at the bottom of the screen, select
the stream you have set to MJPEG. Live video will start streaming to your web browser.

Web Viewer Specifications

Minimum Requirements for PC

CPU Intel P4 2.0GHz Dual Core

RAM More than 1GB

HDD 200 GB Required for Saving Clip Image
0os Microsoft Windows XP or Higher
Resolution Higher than 1024X768
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TROUBLESHOOTING

Before sending your camera for repair, check the following or contact your technical specialist.

Setting the IP Address for your PC
Dynamic Host Configuration Protocol (DHCP) is the default setting for the camera.

If the MEGAPIX camera is connected to a DHCP network and the camera’s IP Configuration Mode is set to DHCP, the
server will automatically assign an IP address to the camera. If the camera is using DHCP, the default IP address will

be 192.168.1.123, and the default subnet mask will be 255.255.255.0.

The MEGAPIX camera can also connect to the web viewer using a static IP address. This will allow you to set your
own IP address manually.

Setup the Network Protocol on your PC.

ok wdpE

~

Go to Network icon on your PC.
Right-click and select Properties.
Double-click Local Area Connection.

Click Properties.

Double-click Internet Protocol Version 4 (TCP/IPv4).
Select Obtain an IP address automatically to set the computer to a dynamic IP address, or select Use the
following IP address to set the computer to a static IP address.

If the option Use the following IP address has been selected, setup the IP address as 192.168.1.XXX. The last

three digits should be a number between 1 and 254.

(L)) |5 » ControlPanel » Network andIntemet » Network and Sharing Center

Control Panel Home

Change advanced sharing | | gcal Area Connection Status =
settings
General
Connection
1Pv4 Connectivity: Internet
1Pv6 Connectivity: No network access
Media State: Enabled
Duration: 00:36:07
Speed: 100.0 Mbps
Detaik... |
By
Activity
Sent l\. i Received
Bytes: 18,931,920 928,109,020
Vametisip I [ :?:!_VProPgrhef J ' Disable \ _ Diagnose ]
Internet Options
Windows Firewall m

< [ Search Cotra Pame

View your basic network information and set up connections

Changeadaptersettings Ry =

O See full map

Internet
Connect or disconnect

ess

nnectfins: § Local Area Connection

connection; or set up a router or access point.

r VPN network connection.

pmputers, or change sharing settings.

leshooting information.
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Internet Protocol Versien 4 (TCP/IPvd) Properties

neral |

You can get IP settings assigned automatically if yvour network supports
this capability, Otherwise, you need to ask your netweork administrator

~1 Obtain an IP address automatically
1@ Use the following IP address:
IP address: 192 .168 . 1 .100

Subnet magk: 285 2585 255 . O

Obtain DMS server address automatically
@) Usg the following DNS server addresses:
Preferred DNS sermver:

Alternate DNS server:

[T]validate settings upon exit
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WARRANTY INFORMATION*

Digital Watchdog (referred to as “the Warrantor”) warrants the Camera against defects in materials or workmanships
as follows:

Labor: For the initial two (2) years from the date of original purchase if the camera is determined to be defective, the
Warrantor will repair or replace the unit with new or refurbished product at its option, at no charge.

Parts: In addition, the Warrantor will supply replacement parts for the initial two (2) years.

To obtain warranty or out of warranty service, please contact a technical support representative at 1-866-446-3595
Monday through Friday from 8:30AM to 8:00PM EST.

A purchase receipt or other proof of the date of the original purchase is required before warranty service is rendered.
This warranty only covers failures due to defects in materials and workmanship which arise during normal use. This
warranty does not cover damages which occurs in shipment or failures which are caused by products not supplied by
the Warrantor or failures which result from accident, misuse, abuse, neglect, mishandling, misapplication, alteration,
modification, faulty installation, set-up adjustments, improper antenna, inadequate signal pickup, maladjustments of
consumer controls, improper operation, power line surge, improper voltage supply, lightning damage, rental use of the
product or service by anyone other than an authorized repair facility or damage that is attributable to acts of God.
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LIMITS & EXCLUSIONS*

There are no express warranties except as listed above. The Warrantor will not be liable for incidental or consequential
damages (including, without limitation, damage to recording media) resulting from the use of these products, or arising
out of any breach of the warranty. All express and implied warranties, including the warranties of merchantability and
fitness for particular purpose, are limited to the applicable warranty period set forth above.

Some states do not allow the exclusion or limitation of incidental or consequential damages or limitations on how long
an implied warranty lasts, so the above exclusions or limitations may not apply to you. This warranty gives you specific
legal rights, and you may also have other rights that vary from state to state.

If the problem is not handled to your satisfaction, then write to the following address:
Digital Watchdog, Inc.

ATTN: RMA Department

5436 W Crenshaw St

Tampa, FL 33634

Service calls which do not involve defective materials or workmanship as determined by the Warrantor, in its sole
discretion, are not covered. Cost of such service calls are the responsibility of the purchaser.
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D O lS T T AL
WATCHDOG

Everything’s Digital

Headquarters Office: 5436 W Crenshaw St, Tampa, FL 33634
Sales Office: 16220 Bloomfield Ave., Cerritos, California, USA 90703
PH: 866-446-3595 | FAX: 813-888-9262
www.Digital-Watchdog.com
technicalsupport@dwcc.tv
Technical Support PH:

USA & Canada 1+ (866) 446-3595
International 1+ (813) 888-9555
French Canadian 1+ (514) 360-1309
Technical Support Hours: Monday-Friday
9:00am to 8:00pm Eastern Standard Time



